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1.Introduction
This User’s Guide describes how to install, use, and troubleshoot the USB2.0
-Ultra SCSI Converter U2SCXU(called U2SCXU in this User’s Guide).
The information in the README file on the CD-ROM may include the latest
information. Be sure to read the file as well.

1-1.Package Confirmation

Check Package Contents:

   � •U2SCXU USB2.0-Ultra SCSI Converter
   � •U2SCXU CD-ROM
   � •User’s Guide
   �  •Software Licence Agreement

NOTE
If any of these items are missing from the U2SCXU retail package,
contact your supplier immediately.
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1-2.System Requirements and Restrictions

    PC

           •USB2.0 enabled PC running Windows XP/2000/Me/98SE
            If your PC doesn’t have the USB2.0 interface, the U2SCXU works
             as USB1.1 device.

    Mac

           •USB enabled Apple PowerMac G4/G3, PowerBook G4/G3,
             iMac/iBook running Mac OS 9.2.1 or later/Mac OS X -10.1 or later.
            The U2SCXU works as USB1.1. With Mac OS, the U2SCXU doesn’t
            work as USB2.0 device.

     SCSI devices
           •High-Density 50 pin female SCSI-2 connector on a SCSI device
           •Term-Power output capability
           (Caution)As U2SCXU gets electric power from Term-Power on
                           SCSI bus, Term-Power output capability is required.
                           If Term-Power output isn’t available at your SCSI
                            device such as iomega Zip drive, you must use an
                             OPTIONAL AC adapter(sold separately).
                           Refer to Chapter 4-10 and 6.
           •Single-End interface
           •Terminator
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     Supported SCSI devices

    PC

           •HDD, Zip, Jaz, ORB, CD-ROM
           •CD-RW
           •DVD-RAM/ROM
           •(Film)Scanner
           •Printer

    Mac

          •HDD, Zip, Jazz, ORB, CD-ROM

     Restrictions
          •PDs, CD Changers aren’t supported(LUN isn’t supported).
           •You can’t change file systems, create partitions on a storage device
             connected to Mac running Mac OS 9.x.
           •Software/utility bundled with a SCSI device may not work.
           •You can’t use USB2.0 on Mac OS. The U2SCXU works as USB1.1
              on Mac OS.
           •You may connect only one SCSI device and may not daisy-chain SCSI
             devices on Mac OS.
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2.Installation

2-1.Connecting the U2SCXU to a SCSI device

Terminator
The fig.1 shows how to connect a terminator and
the U2SCXU when you connect only one SCSI
device.

The fig.2  shows how to connect a terminator and
SCSI cable and the U2SCXU when you connect
daisy-chain SCSI devices.

Terminator

This chapter explains how to connect a SCSI device to the U2SCXU.

Follow the steps through to connect your SCSI device to the U2SCXU:

Fig. 2

Fig. 1
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�1)Make sure the SCSI device is in Power-OFF state.

�2) Decide whether you daisy-chain SCSI devices or not.
    2-1)If you connect two or more SCSI devices, set them as follows:
          Daisy-chain them and attach an external active terminator to the last
          SCSI device, as Fig.2 shows. Turn off the terminator switches on all of
          the SCSI devices if the SCSI devices have internal terminator switches.
          If you are not sure how to turn off terminator switches, refer to
          the user’s manual that accompanied your SCSI device.

    2-2)If you connect only one SCSI device, set it as follows:
           If the SCSI device doesn’t have an internal terminator switch, attach an
           external active terminator to the SCSI device; Otherwise, turn on
           an internal terminator switch. If you are not sure how to turn off
          the terminator switch, refer to the user’s manual that accompanied your
           SCSI device.

�3)Next, connect the U2SCXU to the first(or only) SCSI device.
       If you have a SCSI device with a Low-Density Centronics 50 pin
       or DB25 connector, use an adapter available from us.
       In such a case, refer to Chapter 6.

�4)Make sure each SCSI device has a SCSI ID except 7. You can usually
       change a SCSI ID with a switch on the back of SCSI devices. For more
       information, refer to the user’s manual that accompanied your SCSI device.

�5)If you use a PC, proceed to Chapter 2-2.
       If you use a Mac, proceed to Chapter 2-8.



   
 W

in
do

w
s

6

2-2.Connecting the U2SCXU to a PC

Follow the steps through to connect the U2SCXU attached to SCSI devices:
NOTE
If you use at least one MO drive on Windows Me, proceed to Chapter
2-4-3 first before connect it, and then follow the steps below. Otherwise,
the system will freeze up when you connect the MO to the PC.

1)If your PC is powered down, start it now.
2)Turn on the SCSI devices.
3)Connect the U2SCXU to an available USB port, as Fig.3 shows.
    A LED on the U2SCXU will come on. If the LED doesn’t come on,
     refer to Chapter 4-10.

USB port

Fig. 3

4)If you use a Windows XP user, proceed to Chapter 2-3.
   If you use a Windows Me user, proceed to Chapter 2-4.
   If you use a Windows 2000 user, proceed to Chapter 2-5.
   If you use a Windows 98SE user, proceed to Chapter 2-6.
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2-3.Installing on Windows XP

To install on Windows XP, follow the steps through:

1)Insert the bundled CD-ROM and right-click on [WNASPI32.INF] file
    at the [ASPI32] folder at the [U2SCX] folder, and then, select [Install] from
    the pull-down menu.

2)The next step is different as follows, depending on whether you have daisy-
    chained some SCSI devices or not:

   2-1)
   If you have daisy-chained SCSI devices, or connected only one scanner,
   proceed to Chapter 2-3-1 to install a RATOC original driver.
   2-2)
   If you have connected only one SCSI device such as HDD, Zip, Jaz, CD-
   ROM, CD-R/RW, DVD-RAM/ROM/RW, proceed to Chapter 2-3-2 to
   install a Microsoft Windows XP standard driver.



   
 W

in
do

w
s

8

2-3-1.Installing a RATOC original driver on Windows XP

To install a RATOC original driver on Windows XP, follow the steps through:

1)The following wizard will appear. Make sure the [Install the software
   automatically(Recommended)] option is selected, and then insert the
   bundled CD-ROM.

2)The following wizard will appear. Click [Continue Anyway].
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3)The following wizard will appear. Click [Finish].

4)The following wizard will appear. Make sure the [Install the software
   automatically(Recommended)] option is selected, and then click [Finish].
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5)A warning message will appear again. Click [Continue Anyway].
6)The following wizard will appear. Click [Finish].

7)You have now completed installing the RATOC original driver. To confirm
    the installation is successful, right-click [My Computer] from the [Start]
    menu and select [Properties] from the pull-down menu. Click the [Hard
    ware] tab and click [Device Manager]. If you can find a [RATOC U2SCX
    USB2-SCSI Converter] string without any “!” marks or “?” marks under
    the [SCSI and RAID controllers], and [RATOC USB MassStorage
    Device WDM(withMPD)] string without any “!” marks or “?” marks under
    the [Universal Serial Bus controllers], the installation has completed
    successfully.

8)If you remove the U2SCXU
    from a PC, proceed to 2-7.
    Some utility comes with
    the U2SCXU.
    For more information on it,
    refer to Chapter 3.
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2-3-2.Installing a Microsoft driver on Windows XP

If you have connected only one HDD, Zip, Jaz, CD-ROM, CD-R/RW,
DVD-RAM/ROM/RW, the Windows XP standard driver will be installed
automatically.
To confirm the driver installation, follow the steps through:

1)To confirm the installation is successful, right-click [My Computer] from
   the [Start] menu and select [Properties] from the pull-down menu. Click the
   [Hardware] tab and click [Device Manager]. If you can find a [USB Mass
   Storage Device] string without any “!” marks or “?” marks under the [Uni
   versal Serial Bus controllers], the installation has completed successfully.

8)If you remove the U2SCXU from a PC, proceed to 2-7. Some utility comes
   with the U2SCXU. For more information on it, refer to Chapter 3.
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2-4.Installing on Windows Me

To install on Windows Me, follow the steps through:

   The procedure of the driver installation is different as follows, depending on
   whether you have daisy-chained some SCSI devices, or whether you have
   connected at least on MO drive:

   1)
   If you have daisy-chained SCSI devices, or connected only one scanner,
   proceed to Chapter 2-4-1 to install a RATOC original driver.

   2)
   If you have connected only one SCSI device such as HDD, Zip, Jaz, CD-
   ROM, CD-R/RW, DVD-RAM/ROM/RW, proceed to Chapter 2-4-2 to in
   stall a Microsoft Windows Me standard driver.

   3)
   If you try to use at least one MO, proceed to Chapter 2-4-3 first to install
   a RATOC original driver. If you don’t install the driver, the system will
   freeze up. Be sure to proceed to Chapter 2-4-3 before connecting it.
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2-4-1.Installing a RATOC original driver on Windows Me

To install a RATOC original driver on Windows Me, follow the steps through:

1)The following wizard will appear. Make sure the [Automatic search for
   a better driver(Recommended)] option is selected, and then insert the
   bundled CD-ROM.

2)The following wizard will appear. Click [Finish].
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3)The following wizard will appear. Make sure the [Automatic search for
   a better driver(Recommended)] option is selected, and then click [Next].

4)The following wizard will appear. Click [Finish].
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5)You have now completed installing the RATOC original driver. To confirm
    the installation is successful, right-click [My Computer] and select
    [Properties] from the pull-down menu. Click the [Device Manager] tab.
   If you can find a [RATOC U2SCX USB2-SCSI Converter] string without
   any “!” marks or “?” marks under the [SCSI controllers], and [RATOC
   USB MassStorage Device WDM(withMPD)] string without any “!” marks
   or “?” marks under the [Universal Serial Bus controllers], the installation
   has completed successfully.

6)If you remove the U2SCXU from a PC, proceed to 2-7. Some utility comes
   with the U2SCXU. For more information on it, refer to Chapter 3.



   
 W

in
do

w
s

16

2-4-2.Installing a Microsoft driver on Windows Me

If you have connected only one HDD, Zip, Jaz, CD-ROM, CD-R/RW,
DVD-RAM/ROM/RW, the Windows Me standard driver will be installed
automatically.
To confirm a Microsoft driver installation, follow the steps through:

1)To confirm the installation is successful, right-click [My Computer] and
   select [Properties] from the pull-down menu. Click the [Device Manager]
   tab. If you can find a [USB Mass Storage Device] string under the [Univer
   sal Serial Bus controllers], the installation has completed successfully. A
   green “?” mark may appear with the [USB Mass Storage Device] string, but
  it doesn’t affect the performance of the U2SCX.

2)If you remove the U2SCXU from a PC, proceed to 2-7. Some utility comes
   with the U2SCXU. For more information on it, refer to Chapter 3.
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2-4-3.Using MO drives on Windows Me

If you use at least one MO drive on Windows Me, you need to install a
RATOC driver. If you don’t install the driver, the system will freeze up.
Follow the steps through:

1)Insert the bundled CD-ROM and double-click [Setup.exe] at the [WinMe]
    folder at the [U2SCX] folder.
2)Select your language.
3)If you agree to the terms and conditions, click [Yes].
4)The following window will appear. Click [Finish].

5)You are now ready to connect the U2SCXU to a PC. Proceed to Chapter
   2-2 to connect the U2SCXU.
6)If you remove the U2SCXU from a PC, proceed to 2-7. Some utility comes
   with the U2SCXU. For more information on it, refer to Chapter 3.
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2-5.Installing on Windows 2000

To install on Windows 2000, follow the steps through:

1)Insert the bundled CD-ROM and right-click on [WNASPI32.INF] file
    at the [ASPI32] folder at the [U2SCX] folder, and then, select [Install] from
    the pull-down menu.

2)The next step is different as follows, depending on whether you have daisy-
    chained some SCSI devices or not:
   2-1)
   If you have daisy-chained SCSI devices, or connected only one scanner,
   proceed to Chapter 2-5-1 to install a RATOC original driver.
   2-2)
   If you have connected only one SCSI device such as HDD, Zip, Jaz, CD-
   ROM, CD-R/RW, DVD-RAM/ROM/RW, proceed to Chapter 2-5-2 to
   install a Microsoft Windows 2000 standard driver.
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2-5-1.Installing a RATOC original driver on Windows 2000

To install a RATOC original driver on Windows Me, follow the steps through:

1)The following wizard will appear. Insert the bundled CD-ROM, and then,
   click [Next].

2)The following wizard will appear. Make sure the [Search for a suitable
   driver for my device(Recommended)] option is selected, and then click
   [Next].
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3)The following wizard will appear. Select the [CD-ROM drives] option,
    and then click [Next].

4)The following wizard will appear. Make sure a [rsbulkm.inf] file is found,
    and then click [Next].

5)The following wizard will appear. Click [Finish].
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6)The following wizard will appear. Click [Next].

7)The following wizard will appear. Make sure the [Search for a suitable
   driver for my device(Recommended)] option is selected, and then click
   [Next].

8)The following wizard will appear. Select the [CD-ROM drives] option,
    and then click [Next].
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9)The following wizard will appear. Make sure a [rsblkmpd.inf] file is found,
    and then click [Next].

10)The following wizard will appear. Click [Yes].

11)The following wizard will appear. Click [Finish].
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12)You have now completed installing the RATOC original driver. To confirm
     the installation is successful, right-click [My Computer] and select
      [Properties] from the pull-down menu. Click the [Hardware] tab and click
     [Device Manager]. If you can find a [RATOC U2SCX USB2-SCSI
    Converter] string without any “!” marks or “?” marks under the [SCSI
     and RAID controllers], and [RATOC USB MassStorage Device
     WDM(withMPD)] string without any “!” marks or “?” marks under the
    [Universal Serial Bus controllers], the installation has completed
    successfully.

13)If you remove the U2SCXU from a PC, proceed to 2-7. Some utility comes
     with the U2SCXU. For more information on it, refer to Chapter 3.



   
 W

in
do

w
s

24

2-5-2.Installing a  Microsoft driver on Windows 2000

If you have connected only one HDD, Zip, Jaz, CD-ROM, CD-R/RW,
DVD-RAM/ROM/RW, the Windows 2000 standard driver will be installed
automatically.
To confirm a Microsoft driver installation, follow the steps through:

1)To confirm the installation is successful, right-click [My Computer] and
   select [Properties] from the pull-down menu. Click the [Hardware] tab and
   click [Device Manager]. If you can find a [USB Mass Storage Device]
   string without any “!” marks or “?” marks under the [Universal Serial Bus
   controllers], the installation has completed successfully.

8)If you remove the U2SCXU from a PC, proceed to 2-7. Some utility comes
   with the U2SCXU. For more information on it, refer to Chapter 3.
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2-6.Installing on Windows 98SE
To install a driver on Windows 98SE, follow the steps through:

1)The following wizard will appear. Insert the bundled CD-ROM, and then,
   click [Next].

2)The following wizard will appear.  Make sure the [Search for the best
   driver for your device(Recommended)] option is selected, and then click
   [Next].
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3)The following wizard will appear.  Select the [CD-ROM drives] option,
    and then click [Next].

4)The following wizard will appear. Make sure a [RSBULKM.INF] file is
    found, and then click [Next].

5)The following wizard will appear. Click [Finish].
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6)The following wizard will appear. Click [Next].

7)The following wizard will appear.  Make sure the [Search for the best
   driver for your device(Recommended)] option is selected, and then click
   [Next].

8)The following wizard will appear.  Select the [CD-ROM drives] option,
    and then click [Next].
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9)The following wizard will appear. Make sure a [RSBUKMPD.INF] file is
    found, and then click [Next].

10)The following wizard will appear. Click [Finish].
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11)You have now completed installing the driver. To confirm the installation is
      successful, right-click [My Computer] and select [Properties] from the
      pull-down menu. Click the [Device Manager] tab. If you can find a
     [RATOC U2SCX USB2-SCSI Converter] string without any “!” marks
      or “?” marks under the [SCSI controllers], and [RATOC USB
     MassStorage Device WDM(withMPD)] string without any “!” marks or
      “?” marks under the [Universal Serial Bus controllers], the installation
      has completed successfully.

12)If you remove the U2SCXU from a PC, proceed to 2-7. Some utility comes
    with the U2SCXU. For more information on it, refer to Chapter 3.
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2-7.Removing the U2SCXU from a PC

In order to remove  the U2SCXU, you need to follow the instructions below:

1)Click the removable icon at the task tray located at the lower right corner
   of the desktop.
2)The following pop-up menu will appear. Select it and then you can remove
   the U2SCXU from a PC.

[Windows XP Pop-up menu when the RATOC driver was installed ]

[Windows 2000 Pop-up menu when the RATOC driver was installed ]

[Windows 2000 Pop-up menu when the Microsoft driver was installed ]

[Windows XP Pop-up menu when the Microsoft driver was installed ]
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[Windows Me Pop-up menu when the Microsoft driver was installed ]

[Windows 98SE pop-up menu ]
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2-8.Connecting the U2SCXU to a Mac

Follow the steps through to connect the U2SCXU attached to SCSI devices:

1)If your PC is powered down, start it now.
2)Turn on the SCSI devices.
3)Connect the U2SCXU to an available USB port, as Fig.4 shows.
    A LED on the U2SCXU will come on. If the LED doesn’t come on,
     refer to Chapter 4-10.
4)If you connected a storage device, its icon will mount on the desktop.
   If you remove the U2SCXU from a Mac, move the storage device icon to
   the trash icon, and then you can remove the U2SCXU from a Mac.
   Some utility comes with the U2SCXU. For more information on it, refer to
   Chapter 3.

Fig. 4

USB port
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You can do the followings with the utility:
-You can configure settings for the SCSI device.
-You can update the firmware on the U2SCXU.
-You can format a HDD, Zip, Jaz, MO, etc.(Windows users only)

If you are a Windows user, proceed to Chapter 3-1.
If you are a Mac user, proceed to Chapter 3-2.

3.Utility
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3-1.Using utility on Windows

If you configure settings for a SCSI device or update the firmware on the
U2SCXU, proceed to Chapter 3-1-1. But please note you don’t need to
use this utility if the SCSI device works fine. It is recommended that you
use this utility when you have some problem with the U2SCX.

If you format a HDD, Zip, Jaz, MO, etc., proceed to Chapter 3-1-2.

3-1-1.U2SCXUTY.EXE Utility
You can configure settings for a SCSI device or update the firmware on the
U2SCXU with this U2SCXUTY.EXE utility. In order to use this utility,
follow the steps:

1)Remove the U2SCXU from a PC as described in Chapter 2-7.
   Don’t remove the SCSI device from the U2SCXU.
2)Insert the bundled CD-ROM and double-click [U2SCXUTY.EXE] at the
   [U2SCX] folder. The following window will appear.

3)You will be prompted to connect the U2SCXU to the PC. Connect it.
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4)The following window will appear. If you configure settings for the SCSI
   device, select the [Config Utility] button. Proceed to Chapter A.Config
   Utility for the details. If you update the firmware on the U2SCXU, select the
   [Firmware update Utility] button. Proceed to Chapter B.Firmware update
   Utility for the details.
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A.Config Utility

In order to use this config utility, follow the steps:

1)The following window will appear after you have clicked the [Config
    Utility] button. Refer to the next page for the details on each setting.

2)After you have done your settings, click the [write] button.
   The message saying configuration has completed will appear. Click the
   [cancel] button to go back to the main menu and click the [EXIT] menu.
3)Remove the U2SCXU from the PC as described in Chapter 2-7 and then
    restart the PC. After the PC finished starting, reconnect the U2SCXU for
    your changes to take effect.
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Detailed each setting

[Host SCSI ID] U2SCXU SCSI ID is No. 7.
[TransferSpeed]
Default value is 20MB/s.You can set Max transfer rate from 20,10,5MB/s,
Async.
[Show advanced setting]
When you click this button, the advanced setting window will appear.
[default]
When you click this button, the default settings will be loaded.
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[Mass storage mode]
You can switch from the RATOC original driver to the Microsoft standard
driver by clicking this button, when the U2SCXU is using the RATOC original
driver.
[SCSI emulation mode]
You can switch from the Microsoft standard driver to the RATOC original
driver by clicking this button, when the U2SCXU is using the RATOC original
driver.
[Mass storage mode/SCSI emulation mode Auto]
Automatically detects which mode to take.
[Bus Reset Enable]
Default value is enabled.You can set whether or not the U2SCXU issues
SCSI bus reset to a SCSI device.
[Parity Check Enable]
Default value is enabled. You can set parity check enable or disable.
[Start Unit Enable]
Default value is disabled. You must enable START UNIT command for some
SCSI devices which won’t work if they doesn’t receive this START UNIT
command.
[Power On to Bus Reset Delay Time]
Default value is 0. You can set delay time for some SCSI devices which hang
up if SCSI bus reset is issued right after the U2SCXU gets powered. Set this
value to 2 sec. for Castle Wood ORB drive, Canon FB620S or Sharp JX-370.
[Bus Reset Delay Time]
Default value is 1. You can set delay time for some SCSI devices which hang
up if SCSI command is issued right after SCSI bus resets.
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B.Firmware update Utility

The latest firmware date file will be available on the web site:
(http://www.ratocsystems.com/english)
In order to update the firmware on the U2SCXU, follow the steps:

1)The following window will appear after you have clicked the [Firmware
    update Utility] button. Click the [Write Firm] button.

2)The following window will appear. Select the firmware you want to write
   and click the [Open] button. The extension of a firmware date is “frm”.
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3)The following window will appear. Click [OK].

4)Click the [cancel] button to go back to the main menu and click the [EXIT]
    menu. The following window will appear.

5)Click the removable icon located at the lower right corner of the desktop.
    The following pop-up window will appear and select it.

6)The message saying you can remove the U2SCXU from the PC and then
    click [OK].
7)Click [OK] on the following window.

8)Turn off the SCSI device and restart the PC. After the PC finished starting,
   reconnect the U2SCXU and turn on the SCSI device for your changes to take
   effect.
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    W
indow

sYou can format a HDD, Jaz, Zip drive, etc.,with this utility.
(Caution)
You can’t format a CD-R/RW or DVD-RAM/ROM/RW, etc.

If you are a Windows Me or 98SE user, proceed to Chapter A.
If you are a Windows XP or 2000 user, proceed to Chapter B.

3-1-2.Disk formatting and Partitioning Utility
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Follow the steps through to format your SCSI drive and create partitions:

1)Make sure the SCSI device is connected and powered on.
2)If the device is a removable disk and a media isn’t inserted, insert a media.
3)Double-click a [FRFMTW9X.EXE] file at the [U2Format] folder in the
   bundled CD-ROM.
4)The following window will appear. Select the drive you want to format,
    and click the [Select] button.

A.Format Utility on Windows Me/98SE

(Caution)
The drive lists shows all the devices connected to 1394,USB, SCSI port
on the PC. Be sure to select the drive connected to the U2SCXU.
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5)The following window will appear. Select [Initialize/Format media] from
    the [Edit] menu.

6)The following window will appear. Select format type. If you want to
   do Low Level Format simultaneously, check the [Low Level Format] box.
   Click [OK].
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7)If you selected IBM-PC/AT FDISK format at step 6), the message box
   saying [You should create partition next] appears. Click [OK]. You
   will see the screen shown in step 5) and select [Create Partition] from
   the [Edit] menu. Finally, you will see the screen below. Select [File
   System] from the list box and set Partition size, using the slider bar.
   Click [OK] to create partition. If you selected Super FD format at step 6),
   you will see a screen similar to the following. Select [File System] from the
   list box and click [OK].

8)Remove the U2SCXU from the PC as described in Chapter 2-7 and then
    turn off the SCSI device and reconnect the U2SCXU and turn on the SCSI
    device for your changes to take effect.
    If you are using a removable media, the media will be ejected to take effect.

Slider Bar
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B.Disk Utility on Windows XP/2000

With this utility, you can initialize Master Boot Record or do physical format.
You may resolve the following issues with this disk utility:

•Fails to access to a SCSI disk
•Fails to recognize a SCSI disk even if the SCSI disk was formatted
•Fails to format a SCSI disk

Please note you don’t need to use this utility when you format a new
disk or change partitions. In this case, you need to use “Disk Management”
in Windows XP/2000.

Follow the steps through to use this utility:

1)Make sure the SCSI device is connected and powered on.
2)If the device is a removable disk and a media isn’t inserted, insert a media.
3)Double-click a [U2SFMT2K.EXE] file at the [U2Format] folder in the
   bundled CD-ROM.
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4)The following window will appear. Select the drive you want to format.

(Caution)
The drive lists shows all the devices connected to 1394,USB, SCSI port
on the PC. Be sure to select the drive connected to the U2SCXU.

5)Select the [Initialize MBR] button or [Physical Format] button.
   Please note it will take a very long time, sometime, over one hour, to
   complete physical format.
6)When completing, the message saying the procedure is finished will appear.
7)Remove the U2SCXU from the PC as described in Chapter 2-7 and then
    turn off the SCSI device and reconnect the U2SCXUS and turn on the SCSI
    device for your changes to take effect.

NOTE
1.Some SCSI device can’t be done with physical format.
2.After initializing MBR, you need to execute [Disk Management]
   to create partition and format the SCSI disk. For more information,
   refer to a Help file in Windows XP/2000.
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3-2.Using utility on Mac

If you are a MacOS 9.x user, proceed to Chapter 3-2-1.
If you are a MacOS X user, proceed to Chapter 3-2-2.

NOTE
But please note you don’t need to use this utility if the SCSI device
works fine. It is recommended that you use this utility when you have
some problem with the U2SCX.
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3-2-1.Installing utility on MacOS 9.x

You can configure settings for a SCSI device or update the firmware on the
U2SCXU with this utility. When you update the firmware, don’t remove the
SCSI device from the U2SCXU. You need to keep connecting the U2SCXU
to the SCSI device.

In order to use this utility, you need to duplicate [Mac OS Base] with
[Extensions Manager] first. Secondly, you need to install the utility on Mac
and execute it. Thirdly, you need to go back from [Mac OS Base] to your
settings. In order to use this utility, follow the steps through:

1)Open [Extension Manager] at [Control Panels].
2)Set [Selected Set] to [Mac OS Base] and click [Duplicate Set].
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3)The following window will appear. Type a name such as [U2SCX
    Configuration] and click [OK]. Next, set disable the following
    drivers located at the [Extensions Manager].

-USB Authoring Support
-Authoring Support
-Disc Banner Extension

4)Insert the bundled CD-ROM.
5)Double-click [U2SCX-Configuration-E] at the [U2SCX] folder.
6)Follow the on-screen instructions and the following window will appear.
   Make sure the destination folder and click [Install].
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7)The following window will appear. Click [Quit].

8)You can find the [U2SCX] folder created at the destination you have made
    sure of it at step 6. Start U2SCX utility. The following window will appear.
    If you have the U2SCXU removed from a Mac, reconnect it.
    If you have already removed the U2SCXU, connect it. After connecting,
    click [OK].

9)The following window will appear. Click [OK].

10)You are now ready to start the utility from the [File] menu.
      Select [Quit] from the [File] menu.

If you want to configure settings for a SCSI device connected to the U2SCXU,
you need to select [Config Utility] from the [File] menu. Proceed to A.
If you want to update a firmware date on the U2SCXU, you need to select
[Firmware update Utility] from the [File] menu. Proceed to B.
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A.Config Utility

In order to use this config utility, follow the steps:

Don’t remove the SCSI device from the U2SCXU.

1)Before you start this utility, you need to make sure of the following points:

   a)Open [Extensions Manager] at [Control Panels].
   b)Make sure your setting is [U2SCX Configuration] you made at step 3)
       in Chapter 3-2-1.
   c)Make sure the following drivers are enabled.
      -U2SCXUsermodeDriver
      -U2SCXUsermodeUTDriver
   d)Make sure the following drivers are disabled.
      -USB Authoring Support
      -Authoring Support
      -Disc Banner Extension
2)Make sure the U2SCXU is removed from a Mac and start the U2SCX
   Utility at the [U2SCX] folder. The following window will appear. Connect
   the U2SCXU to the Mac and click [OK].
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3)The following window will appear. Click [OK].

4)Select [Config Utility] from the [File] menu. The following window will
   appear. Refer to A in Chapter 3-1-1 for each item.

   When you click the [Advanced] button, the following window will appear.
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5)After you have done settings, click [Write]. The message saying updating
    completed will appear. Click [OK]. Select [Quit] from the [File] menu.
    Remove the U2SCXU from the Mac and turn off the SCSI device attached
    to the U2SCXU.
6)Change the settings from [U2SCX Configuration] to the previous setting
    with [Extensions Manager] and restart your Mac. Turn on the SCSI device
     and connect the U2SCXU to the Mac. Your settings now starts working.
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B.Firmware update Utility

The latest firmware date file will be available on the web site:
(http://www.ratocsystems.com/english)
In order to update the firmware on the U2SCXU, follow the steps:

1)Before you start this utility, you need to make sure of the following points:

   a)Open [Extensions Manager] at [Control Panels].
   b)Make sure your setting is [U2SCX Configuration] you made at step 3)
       in Chapter 3-2-1.
   c)Make sure the following drivers are enabled.
      -U2SCXUsermodeDriver
      -U2SCXUsermodeUTDriver
   d)Make sure the following drivers are disabled.
      -USB Authoring Support
      -Authoring Support
      -Disc Banner Extension
2)Make sure the U2SCXU is removed from a Mac and start the U2SCX
   Utility at the [U2SCX] folder. The following window will appear. Connect
   the U2SCXU to the Mac and click [OK].
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3)The following window will appear. Click [OK].

4)Select [Firmware update Utility] from the [File] menu. The following
   window will appear. [Firmware Rev] means the current revision of the
   firmware on the U2SCXU.

5)Select [Select New Firmware Data File] and select a new firmware data
    file(The extension of a firmware data file is “frm”) and then click [OK].
    Firmware Rev. on the window means the current revision of the firmware on
    the U2SCXU.
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6)The window shown at step 4) will appear. Click [Write].
   The message saying updating completed will appear. Click [OK]. Select
   [Quit] from the [File] menu. Remove the U2SCXU from the Mac and turn
   off the SCSI device attached to the U2SCXU.
7)Change the settings from [U2SCX Configuration] to the previous setting
    with [Extensions Manager] and restart your Mac. Turn on the SCSI device
    and connect the U2SCXU to the Mac. Your settings now starts working.



    M
acintosh

57

3-2-2.Using utility on MacOS X

You can configure settings for a SCSI device or update the firmware on the
U2SCXU with this utility. When you update the firmware, don’t remove the
SCSI device from the U2SCXU. You need to keep connecting the U2SCXU
to the SCSI device.

In order to use this utility, follow the steps through:

1)Insert the bundled CD-ROM.
2)Make sure the U2SCXU is removed from a Mac and double-click
   [U2SCX Utility] at the [U2SCX_OSX] folder at the [U2SCX] folder.

3)The following window will appear. Click [OK].
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4)Connect the U2SCXU to the Mac. The following window will appear.

If you want to configure settings for a SCSI device connected to the U2SCXU,
proceed to A.
If you want to update a firmware date on the U2SCXU, proceed to B.
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A.Config Utility

You can configure settings for a SCSI device with the utility shown in the
previous page. Refer to A in Chapter 3-1-1 for each item.

1)Click the [Start Configuration setting] button.
2)The following window will appear. Click [OK].

3)Remove the U2SCXU from the Mac and turn off the SCSI device attached to
   the U2SCXU.
4)Click the [Quit U2SCX Utility] button. The following window will appear.
    Click [OK].

7)Turn on the SCSI device and connect the U2SCXU to the Mac. Your settings
   now starts working
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B.Firmware update Utility

The latest firmware date file will be available on the web site:
(http://www.ratocsystems.com/english)
In order to update the firmware on the U2SCXU, follow the steps:

1)Click the [Select firmware data] button.
2)Select a new firmware data file(The extension of a firmware data file is “frm”)
    and then click [Open].

3)Click the [Start Firmware update] button.
4)The following window will appear. Click [OK].

5)Remove the U2SCXU from the Mac and turn off the SCSI device attached to
   the U2SCXU.
6)Click the [Quit U2SCX Utility] button. The following window will appear.
    Click [OK].

7)Turn on the SCSI device and connect the U2SCXU to the Mac. Your settings
   now starts working
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4.Troubleshooting

4-1.General Hardware Troubleshooting

� Be sure the U2SCXU’s power LED comes on. If the LED doesn’t come on,
    your SCSI device may not provide SCSI bus termination power. If the
    SCSI device can’t provide it, an OPTIONAL AC adapter is required.
    For purchasing information, refer to Chapter 6.
� Be sure the U2SCXU is firmly connected to your SCSI device.
� Be sure the USB cable is firmly connected to a USB port on your PC or Mac.
� Be sure each SCSI device has a SCSI ID except 7.
� Be sure the SCSI power cable is properly connected and the SCSI device
    is powered.
� Be sure the last SCSI device has a terminator.
� Some SCSI devices may not have the capability of providing enough
    termination power to the U2SCXU. We recommend you use an OPTIONAL
    AC adapter to avoid it. For purchasing information, refer to Chapter 6.
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4-2.Deleting the RATOC original driver(Windows XP/2000)

Follow the steps to delete the RATOC original driver:
1.Removing the strings from Device Manager as follows:
   a.Right-click on My Computer.
   b.Select Properties.
   c.Select the Hardware tab.
   d.Click the Device Manager button.
   e.Double-click SCSI and RAID controllers.
   f.Select RATOC U2SCX USB2-SCSI Converter and delete it.
   g.Double-click Universal Serial Bus controllers.
   h.Select RATOC USB MassStorage Device WDM(withMPD) and
      delete it.
2.Removing the INF file:
   a.Double-click the My Computer icon.
   b.Select Folder Options in the Tools menu and select the View tab.
   c.Put a check mark at the Show hidden files and folders.
   d.Click the Apply button and then click the OK button
   e.If you are a Windows XP user, open a INF folder at the Windows folder
      in the C drive. If you are a Windows 2000 user, open a INF folder at the
      WINNT folder in the C drive.
   f.Search an oemX.inf(X means a number).
     Open each oemX.inf file to find the file related to the U2SCXU.
     If you found a U2SCX string in the file, delete it. You also need delete the
     file of which extension is PNF and the same file name(oemX).
     For instance, if you found an oem3.inf related to the U2SCX, delete both of
     the oem3.inf and oem3.pnf. Remove the U2SCXU and you have finished it.
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4-3.Deleting the RATOC original driver (Windows Me/98SE)

Follow the steps to delete the RATOC original driver:

1.Removing the strings from Device Manager:
   a.Right-click on My Computer.
   b.Select Properties.
   c.Select the Device Manager tab.
   d.Double-click SCSI controllers.
   e.Select RATOC U2SCX USB2-SCSI Converter and delete it.
   f.Double-click Universal Serial Bus controllers.
   g.Select RATOC USB MassStorage Device WDM(withMPD) and
      delete it.

2.Removing the INF file:
   a.Double-click the My Computer icon.
   b.Select (Folder)Options in the View(Tools) menu and select the View tab.
   c.Put a check mark at the Show all files(Show hidden files and folders).
   d.Click the Apply button and then click the OK button
   e.Select Find(Search) and (For)Files or Folders on the Start menu.
   f.Type [RATOC Systems,Inc.RSBLKMPD.INF].
   g.Select the drive where Windows Me/98SE is installed in Look in box.
   h.Click the Find Now(Search Now) button.
   i.If the file appeared, delete it. In the same way, delete an [RATOC
     Systems,Inc.RSBLKM.INF] file.
Remove the U2SCXU and you have finished deleting the drivers.
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4-4.Updating the RATOC original driver(Windows XP)

When you have a new driver through our web site, you can update the driver
as follows:

1)Delete the old drivers as described in Chapter 4-2.
2)Connect the U2SCXU to an available USB port on your PC.
    The following window will appear. Select the [Install from a list or
    specific location(Advanced)] option and click [Next].

3)Select the [Include this location in the search] option and click [Browse].
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4)Select the folder containing the U2SCXU driver. Click [OK].

5)The selected location is shown and click [Next].

6)The following window will appear and click [Continue Anyway].
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7)The following window will appear and click [Finish].

8)Select the [Install from a list or specific location(Advanced)] option and
    click [Next].

9)The same location you have selected at step 4 is shown and click [Next].
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10)The following window will appear and click [Continue Anyway].

11)The following window will appear and click [Finish].

You have now finished updating the drivers.
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4-5.Updating the RATOC original driver  (Windows Me)

When you have a new driver through our web site, you can update the driver
as follows:
1)Delete the old drivers as described in Chapter 4-3.
2)Connect the U2SCXU to an available USB port on your PC.
    The following window will appear. Select the [Specify the location of the
    driver(Advanced)] option and click [Next].

3)Select the [Specify a location] option and click [Browse].
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4)Select the folder containing the U2SCXU driver. Click [OK].

5)The selected location is shown and click [Next].

6)Click [Next].
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7)The following window will appear and click [Finish].

8)The following window will appear. Select the [Specify the location of the
    driver(Advanced)] option and click [Next].

9)The same location you have selected at step 3 is shown and click [Next].
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10)Click [Next].

11)The following window will appear and click [Finish].

You have now finished updating the drivers.
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4-6.Updating the RATOC original driver (Windows 2000)

When you have a new driver through our web site, you can update the driver
as follows:
1)Delete the old drivers as described in Chapter 4-2.
2)Connect the U2SCXU to an available USB port on your PC.
    The following window will appear. Click [Next].

3)The following window will appear. Select the [Search for a suitable driver
    for my device(Recommended)] option and click [Next].
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4)The following window will appear. Select the [Specify a location] option
    and click [Next].

5)The following window will appear. Click [Browse].

6)Select the folder containing the U2SCXU driver. Click [Open].
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7)The selected location is shown and click [OK].

8)Click [Next].

9)The following window will appear and click [Finish].
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10)Click [Next].

11)The following window will appear. Select the [Search for a suitable driver
     for my device(Recommended)] option and click [Next].

12)The following window will appear. Select the [Specify a location] option
      and click [Next].
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13)The same location you have selected at step 6 is shown and click [OK].

14)Click [Next].

15)The following window will appear and click [Yes].

16)The following window will appear and click [Finish] and then restart your
     PC. You have now finished updating the drivers.
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4-7.Updating the RATOC original driver(Windows 98SE)

When you have a new driver through our web site, you can update the driver
as follows:
1)Delete the old drivers as described in Chapter 4-3.
2)Connect the U2SCXU to an available USB port on your PC.
    The following window will appear. Click [Next].

3)The following window will appear. Select the [Search for the best driver
     for your device(Recommended)] option and click [Next].
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4)The following window will appear. Select the [Specify a location] option
    and click [Next].

5)Select the folder containing the U2SCXU driver. Click [OK].

6)The selected location is shown and click [Next].
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7)Click [Next].

8)The following window will appear and click [Finish].

9)The following window will appear and click [Next].
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10)The following window will appear. Select the [Search for the best driver
      for your device(Recommended)] option and click [Next].

11)The same location you have selected at step 6 is shown and click [OK].

12)Click [Next].



81

13)The following window will appear and click [Finish].
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When you come across an error message while you are copying files or the
system locks up, you should phase down transfer rate with the SCSI configu-
ration utility. If you use some older MO models made by FUJITSU such as
M2512A, M2513A, the system sometimes locks up.
If you use these old FUJITSU MO models, remove the U2SCXU from the
SCSI device and attach the U2SCXU to another SCSI device to set transfer rate
to 10MB/sec with the SCSI configuration utility. Please note you can’t execute
the SCSI configuration utility with the older FUJITSU MO models attached to
the U2SCXU. You must attach the U2SCXU to another SCSI device.

If you are a Windows user, proceed to section A in Chapter 3-1-1. With the
SCSI configuration utility, phase down the transfer rate to see if it is successful.

If you use Mac OS 9.x, proceed to section A in Chapter 3-2-1. With the
SCSI configuration utility, phase down the transfer rate to see if it is successful.

If you use Mac OS X, proceed to section A in Chapter 3-2-2. With the SCSI
configuration utility, phase down the transfer rate to see if it is successful.

4-8.When you fail to copy files or use FUJITSU MO
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When you connect a HDD which isn’t formatted or doesn’t have partitions, a
new drive letter won’t be assigned in [My Computer]. You need to format or
create partitions on the HDD.

1.When you use Windows Me/98SE, you can format your HDD and create
   partitions with the bundled “Format Utility”. You have to format and
   create partition for your HDD. You must do both of them for your HDD.
   For more information, refer to section A in Chapter 3-1-2.

2.When you use Windows XP/2000, you can format your HDD and create
   partitions with Disk Management in Windows XP/2000. For more
   information, refer to a Windows XP/2000 help file. If a new drive letter
   won’t be assigned yet or you still fail to format the HDD after you have
   done Disk Management, you should do Low Level Format, using    with
the bundled “Disk Utility”, and then do the Disk Management.    For
more information, refer to section B in Chapter 3-1-2.

4-9.When a new drive letter isn’t assigned(Windows)
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Check the following points:
1)Be sure the SCSI device is powered on properly.
2)Turn off the SCSI device and make sure the U2SCXU is attached firmly, and
   turn on the device again.

   If the LED doesn’t come on even if you have done the above checking,
   refer to the user’s document on the SCSI device. Though SCSI specifications
   require Term-Power output capability as an optional, some SCSI devices
   such as iomega Zip drive may not be implemented this capability. If your
   SCSI device doesn’t have this Term-Power output capability, you must
   connect an OPTIONAL AC adapter(sold separately) as shown below or
   daisy-chain a SCSI device which has this Term-Power output capability.
   But, if you are a Mac user, don’t daisy-chain another SCSI device. Windows
   users only can daisy-chain another SCSI device.  If you are a Mac user, you
   must connect the optional AC adapter.
   For purchasing information, refer to Chapter 6.

4-10.When the power LED doesn’t come on(Win/Mac)

Optional AC adapter

AC adapter jack
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This problem is caused by the specifications of the U2SCXU. Don’t remove
the U2SCXU while a scanner is scanning.

4-12.A message saying [The device “RATOC USB Mass
     Storage Device WDM (withMPD) cannot be
     stopped because a program is still running”]
     appears when you try to remove the CBU2U
         removable icon(RATOC CB USB Enhanced Host
           Controller)(Win/Mac)

4-11.A message saying [Scanning failed] appears when
          you  removed the U2SCXU removable icon(RATOC
         U2SCX-USB2 SCSI Converter)(Win/Mac)

This problem is caused by the specifications of the U2SCXU. Remove
the U2SCXU first before the CBU2U.
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4-13.Wizard starts up with a scanner connected(Windows)

When you connect the U2SCXU connected to scanner to a PC, wizard will
start up because the driver of the scanner is required. In this case, specify
the driver provided by its manufacturer.
Here is the procedures for Windows XP or Me users. If you are a Windows
2000 or 98SE user, you can nearly follow the same procedure to install the
driver.

[For Windows XP users]
1.A wizard will appear after you have finished installing the driver for the
   U2SCXU. Select the [Install from a list or specific location(Advanced)]
   option and click [Next].
2. Select the [Don’t search. I will choose the driver to install] option and
   click [Next].
3.Select [Imaging Device] from the list and click [Next].
4.Click the [Have disk] button.
5.Specify the location where the scanner driver exists and then click [OK].
6.Make sure the model name you have specified is shown on the list and then
    click [Next].
7.A warning message will appear. Click [Continue Anyway].
8.Click [Finish]. You have now completed the driver.
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[For Windows Me users]
1.A wizard will appear after you have finished installing the driver for the
   U2SCXU. Select the [Specify the location of the driver(Advanced)]
   option and click [Next].
2. Select the [Display a list of all the drivers in a specific location, so you
    can select the driver you want] option and click [Next].
3.Select [Imaging Device] from the list and click [Next].
4.Click the [Have disk] button.
5.Specify the location where the scanner driver exists and then click [OK].
6.Make sure the model name you have specified is shown on the list and then
    click [Next].
7.Click [Next].
8.Click [Finish]. You have now completed the driver.
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5.Registration and Tech-Support
5-1. How to Register

We highly recommend to register yourself as our customer through our

on-line registration. (http://www.ratocsystems.com/english/)

5-2. Software Update and Support

-Utility Update-

The latest utility is subject to change for improvement or bug fix.You can

download the latest version from our web site.

-Technical Support-

You can get a Tech support from RATOC at the following:

(Open Monday - Friday,9:30A.M. to 5:00P.M.(PST))

RATOC Systems International,Inc. Tech support

Address: 1933 O’Toole Avenue Suite A109

SanJose, CA 95131, U.S.A.

Phone : (408)955-9400  Fax : (408)955-9402

E-mail : int-support@rexpccard.co.jp

Web : http://www.ratocsystems.com/english/

Please include the following information:

•Our product name, serial number, and product description

•Host Computer Name, OS version,CD-ROM version
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6.Options

Optional AC adapters,  etc. are available (sold separately) at the web site:

   1.http://www.ratocsytems.com/english/

   2.http://www.firewireshop.com

    -RCL-3005    (HD50F to C50P adapter)

    -RCL-3025    (HD50F to DB25P adapter)

    -AC05            (AC Adapter:Input AC100-240V, Output DC 5V, 2A)

If you have any questions about these options, contact to:

RATOC Systems International, Inc. Tech support:

   Tel      : (408)955-9400

   Fax     : (408)955-9402

   E-mail: int-sales@rexpccard.co.jp
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7.Specifications

Product Name :U2SCXU

Transfer          :SCSI

  •Max synchronous transfer 20MBytes/sec

    (When you connect an Ultra SCSI device)

  •Max synchronous transfer 10MBytes/sec

    (When you connect a SCSI-2 device)

  •Max asynchronous transfer 5MBytes/sec

                          USB

              •480/12/1.5Mbps

SCSI connector:High-Density 50 pin male SCSI-2 connector x 1

USB connector: USB Type A x 1

Size:2.01 in (51 mm) (W) x 2.05 in (52 mm) (L) x 0.71 in (18 mm) (H)

Power Requirements :+5V

 (SCSI Term Power must provide, if the SCSI Term Power can’t provide,  an

  optional adapter is required)

Power Consumption: USB BUS 2mA or below, Term Power 300 mA MAX

Optional AC Adapter:Input AC100-240V, Output DC 5V, 2
Polarity
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Appendix
Trademarks

-Windows is a registered trademark of Microsoft Corporation.

-MacOS, PowerMacintosh, PowerBook and Mac logo are registered trademarks

 of Apple Computer,Inc.

-Other brand and product names may be registered trademarks or trademarks of

 their respective holders.

Regulatory Agency Notices
FCC Compliance Statement

This equipment has been tested and found to comply with the limits for a Class B digital device,

pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection

against harmful interference in a residential installation. This equipment generates, uses and can

radiate radio frequency energy and, if not installed and used in accordance with the instructions,

may cause harmful interference to radio communications. However, there is no guarantee that

interference will not occur in a particular installation. If this equipment does cause harmful

interference to radio or television reception, which can be determined by turning the equipment

off and on, the user is encouraged to try to correct the interference by one or more of the

following measures:

(1) Reorient or relocate the receiving antenna.

(2) Increase the separation between the equipment and receiver.

(3) Connect the equipment into an outlet on a circuit different from that to which the receiver is

      connected.

(4) Consult the dealer or an experienced radio/TV technician for help.

Changes or modifications not expressly approved by the party responsible for compliance may

result in this unit not complying with FCC Rules Part 15.

Manufacturer declaration

This certifies that the U2SCXU complies with the EN55022(Class B) and EN55024 requirements.




	U2SCXU User's Guide
	Index
	1.Introduction
	1-1.Package Confirmation
	1-2.System Requirements and Restrictions

	2.Installation
	2-1.Connecting the U2SCXU to a SCSI device
	2-2.Connecting the U2SCXU to a PC
	2-3.Installing on Windows XP
	2-3-1.Installing a RATOC original driver on Windows XP
	2-3-2.Installing a Microsoft driver on Windows XP

	2-4.Installing on Windows Me
	2-4-1.Installing a RATOC original driver on Windows Me
	2-4-2.Installing a Microsoft driver on Windows Me
	2-4-3.Using MO drives on Windows Me

	2-5.Installing on Windows 2000
	2-5-1.Installing a RATOC original driver on Windows 2000
	2-5-2.Installing a Microsoft driver on Windows 2000

	2-6.Installing on Windows 98SE
	2-7.Removing the U2SCXU from a PC
	2-8.Connecting the U2SCXU to a Mac

	3.Utility
	3-1.Using utility on Windows
	3-1-1.U2SCXUTY.EXE Utility
	A.Config Utility
	B.Firmware update Utility

	3-1-2.Disk formatting and Partitioning Utility
	A.Format Utility on Windows Me/98SE
	B.Disk Utility on Windows XP/2000


	3-2.Using utility on Mac
	3-2-1.Installing utility on MacOS 9.x
	A.Config Utility
	B.Firmware update Utility

	3-2-2.Using utility on MacOS X
	A.Config Utility
	B.Firmware update Utility



	4.Troubleshooting
	4-1.General Hardware Troubleshooting
	4-2.Deleting the RATOC original driver(Windows XP/2000)
	4-3.Deleting the RATOC original driver (Windows Me/98SE)
	4-4.Updating the RATOC original driver(Windows XP)
	4-5.Updating the RATOC original driver (Windows Me)
	4-6.Updating the RATOC original driver (Windows 2000)
	4-7.Updating the RATOC original driver(Windows 98SE)
	4-8.When you fail to copy files or use FUJITSU MO
	4-9.When a new drive letter isn’t assigned(Windows)
	4-10.When the power LED doesn’t come on(Win/Mac)
	4-11.A message saying [Scanning failed] appears when you removed the U2SCXU removable icon(RATOC U2SCX-USB2 SCSI Converter)(Win/Mac)
	4-12.A message saying [The device “RATOC USB Mass Storage Device WDM (withMPD) cannot be 
stopped because a program is still running”] 
appears when you try to remove the CBU2U removable icon(RATOC CB USB Enhanced Host Controller)(Win/Mac)
	4-13.Wizard starts up with a scanner connected(Windows)

	5.Registration and Tech-Support
	5-1. How to Register
	5-2. Software Update and Support

	6.Options
	7.Specifications
	Appendix



